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H3Cクラウドラボのクイックスタート 

H3C Cloud Lab(HCL)は、デバイスの調査、テスト、トラブルシューティングを行うためのグラフィカルな

ネットワーク シミュレーション ソフトウェアツールです。Comware7ベースのデバイスの複数のモデルをシ

ミュレートするために使用できます。 

この章では、次のようなH3C Cloud Labの基本的な操作について説明します。 

HCLホームページ 

基本的なHCL操作の開始 

HCLのホームページ 

デスクトップのHCLショートカットアイコンをダブルクリックすると、HCLを起動できます。起

動後、図1に示すように、HCLのホームページが表示されます。 

HCLホームページには、図2に示すように8つの領域があります。表1に、ホームページの

領域を示します。 

図1 HCLのホームページ 
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図2 HCLホームページのレイアウト 
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表1 HCLのホームページ領域 

エリア 説明 

 
 
 
 

タイトルとメニューバー 

現在のプロジェクトの名前 

 HCL-test[ D:\HCL\Projects\Test]のように、現

在のプロジェクトの名前とパスが事前定義されて

いる文字列で表示されます。プロジェクトを開い

ていない場合は、一時プロジェクト名がHCL-

hcl_6-文字長の乱数temp project形式で表示さ

れます。 

ドロップダウンメニューアイコンが(右上隅に)表示

されます。アイコンをクリックすると、メニューが表

示されます。メニューの詳細は、「ドロップダウン

メニュー」を参照してください。 

 
 

ショートカットアイコンバー 

プロジェクト操作の実行、デバイスの開始と停止、

デバイス名、インタフェース名およびグリッドの表

示と非表示、長方形と楕円の描画、ズームインと

ズーム・アウトおよびスナップショットを行うための

ショートカットアイコンが表示されます。アイコンの

上にカーソルを置くと、アイコンの機能を表示でき

ます。 

 

デバイスとリンク 
ワークスペースに追加できるルーター、スイッチ、

ファイアウォール、エンドデバイス、リンクを表示し

ます。また、必要に応じてデバイスをDIYすること

もできます。 

 

ワークスペース 
デバイスおよびリンクを追加して論理ネットワー

クを設定できます。デバイスおよびリンクを追加

または削除してトポロジーを変更できます。 

 

キャプチャーインタフェース

リスト 

パケットキャプチャーが構成されているすべての

インタフェースを一覧表示します。右クリックメニ

ューを使用して、キャプチャーを停止し、キャプチ

ャーされたパケットを表示できます。 

 

トポロジーの概要 
ネットワークトポロジー内のすべてのデバイスおよ

びリンクを表示します。簡単なトポロジー操作を実

行するルーターを右クリックするとメニューが表示

されます。 

著作権およびバージョン HCLの著作権およびバージョン情報を表示しま

す。 

パーソナルセンター ログインページを提供します。 
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基本的なHCL操作の開始 
このセクションでは、次の基本的なHCL操作について説明します。 

⚫ プロジェクトの作成 

⚫ デバイスの追加 

⚫ 操作装置 

⚫ プロジェクトの保存 

⚫ プロジェクトを開く 

⚫ HCLの終了  

操作の詳細については、該当するセクションを参照してください。 

制限事項およびガイドライン 
HCLは、同時に最大20ユーザーをサポートします。 

複数のユーザーが同じホスト上でHCLを使用するには、ユーザーがホストにTelnet接続で

きるように、ホスト上でWindows仮想デスクトップサービスを有効にする必要があります。 

1人のユーザーが同時に開くことができるHCLウィンドウの最大数は20です。 

プロジェクトを作成する 

HCLを開始すると、一時プロジェクトが自動的に作成されます。一時プロジェクトの作業エリアに

トポロジーを作成するか、図3に示すように、ショートカットアイコンバーのNew Projectアイコン

をクリックしてプロジェクトを作成できます。  

図3 プロジェクトの作成 
 

 

  



HCL-10 
 

デバイスの追加 

制限事項およびガイドライン 
プロジェクトには、合計で最大50台のDIYデバイス、ルーター、スイッチ、ファイアウォール、およびエンドデ

バイスを含めることができます。 

プロジェクトには最大ホスト(ローカルPC)を含めることができます。 

プロジェクトには、最大50台のリモートPC(リモートネットワークプロキシ)を含めることができます。 

デバイスを追加するには 

1. デバイスとリンクエリアでデバイスをクリックします。デバイスタイプにはDIY装置、ルーター、スイッチと

ファイアウォールが含まれます。 

図4に示すように、デバイスモデルリストが表示されます。 

2. デバイスを追加するには、次のいずれかの方法を使用します。 

Adding one device: Clickをクリックし、デバイスモデルをワークスペースにドラッグ

します。 

Adding multiple devices of the same model: Clickしてから、作業エリアでデバイスを

配置する位置をクリックします。デバイスの追加を停止するには、Escキーを押します。 

デバイスの追加には時間がかかります。デバイスを追加する位置をクリックした後は、デバイスの追加

が完了するまで、その後のクリック操作は無視されます。 

図4 デバイスモデルの選択 

 
 

装置の操作 

デバイスを操作するには、デバイスを右クリックして右クリックメニューを表示し、実行する操作を選択し

ます。 

右クリックメニューは、デバイスのステータスによって異なります。図5は、デバイスが停止している場合

の右クリックメニューを示しています。図6は、デバイスが起動している場合の右クリックメニューを示して

います。 
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図5 デバイスの停止時の右クリックメニュー 

 

図6 デバイスの起動時の右クリックメニュー 

 

右クリックメニューの基本操作は次のとおりです。 

 Start： デバイスを起動します。起動されたデバイスのアイコンは緑色です。 

Stop： デバイスを停止します。停止したデバイスのアイコンは白です。リンクをAdd Links： デバイ
スを他のデバイスに接続するためのリンクを追加します。Add linksをクリックすると、カーソルがクロ

ス記号に変わります。次に、デバイスをクリックして、ポップアップインタフェースリストからソースインタ

フェースを選択し、別のデバイスをクリックして、2つのインタフェースを接続する宛先インタフェースを

選択できます。リンクをさらに追加するには、この操作を繰り返します。 

リンクの追加を停止するには、作業エリアの何もないスペースを右クリックします。 
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図7 リンクの追加 

 

start CLI： デバイスのCLIを起動します。図8はデバイスのCLIを示しています。CLIのタイトルは
次のようになります。デバイス名。 

図8 CLIの例 

 

Delete： デバイスを削除します。 

 

プロジェクトを保存する 

プロジェクトを確定したら、ショートカットアイコンバーのSave Projectアイコンをクリックしてプ

ロジェクトを保存します。現在のプロジェクトが一時的なプロジェクトの場合は、プロジェクト名

とパスを入力するためのダイアログボックスが表示されます。  
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プロジェクトを開く 

プロジェクトを開くには、図9に示すように、ショートカットアイコンバーのOpen Projectア

イコンをクリックし、開くプロジェクトをダブルクリックします。  

図9 プロジェクトを開く 

 

HCLの終了 

HCLを閉じるには、HCLウィンドウの右上隅にある閉じるCloseアイコンをクリックします。  
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ドロップダウンメニュー 
この章では、ドロップダウンメニューについて説明します。 

この章は次の項で構成されています。 

⚫ プロジェクト 

⚫ 編集 

⚫ 設定 

⚫ 表示 

⚫ ヘルプ 

⚫ ログファイルの収集  

⚫ 終了 

 

図10に示すように、メニューバーのMenuドロップダウンアイコンをクリックして、ドロップダウンメニ

ューにアクセスします。  

図10 ドロップダウンメニュー 
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プロジェクト 
図11は、Projectで使用可能なサブメニューを示しています。 

図11 Projectのサブメニュー 

 

新規 
1. ドロップダウンメニューから、Project > Openをクリックします。 

図12に示すように、ダイアログボックスが開きます。 

図12 新しいプロジェクトの作成 

 

2. プロジェクト名を入力します。 

名前は最大20文字の、大文字と小文字を区別しない文字列です。有効な文字は、文字、数

字およびアンダースコアです。 

Browseをクリックして、プロジェクトファイルを保存するディレクトリを変更できます。 

3. OKをクリックします。 

新しいプロジェクトを作成するには、ショートカットアイコンバーのNew Projectアイコンをクリックす

ることもできます。 
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オープン 
1. ドロップダウンメニューから、Project > Openをクリックします。図13に示すように、ダイアログボッ

クスが開き、ユーザーが作成したすべてのプロジェクトが表示されます。 

2. プロジェクトに対して次の操作を実行できます。 

· プロジェクトをクリックして選択します。 

· プロジェクトをダブルクリックして開きます。 

· プロジェクトの上にカーソルを置くと、プロジェクトの完全なパスが表示されます。 

3. ターゲットプロジェクトファイルがダイアログボックスに表示されない場合は、Browseをクリックして

ファイルを選択できます。サポートされるファイルには、.netファイルと.hclファイルが含まれま

す.hclファイルの詳細は、Exportを参照してください。 

また、ショートカットアイコンバーのOpenアイコンをクリックすると、プロジェクトを開くことが

できます。使用可能なプロジェクトがない場合は、Browseをクリックして開くウィンドウと同

様に、ファイル選択ウィンドウが開きます。 

図13 プロジェクトを開く 
 

 

注: 2つのHCLウィンドウで同じプロジェクトを開くことはできません 
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削除 

1. ドロップダウンメニューからProject > Removeをクリックします。 

図14に示すように、ダイアログボックスが開き、ユーザーが作成したすべてのプロジェク

トが表示されます。 

2. プロジェクトをダブルクリックして、プロジェクトを削除します。 

図14プロジェクトの削除 
 

保存と名前を付けて保存 

⚫ 一時プロジェクトを操作している場合、SaveまたはSave asをクリックすると、図15

に示すようなダイアログボックスが表示されます。 

HCLは自動的にhcl_で始まるプロジェクト名を提供します。次の6文字はランダムに

生成されます。 

⚫ プロジェクトが一時的なものでない場合: 

Saveをクリックすると、プロジェクトが直接保存されます。 

Save asをクリックすると、プロジェクトを保存するためのダイアログボックスが開きま

す。 
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図15 プロジェクトの保存 
 

 
プロジェクトを保存するには、Save projectアイコンをクリックします。 

 

注: 

プロジェクト名は最大20文字の文字列で、大文字と小文字は区別されません。有効な

文字は、文字、数字、およびアンダースコアです。 

 

エクスポート 

プロジェクトは個別のフォルダに保存されます。162に示すように、プロジェクトフォルダにはプロ

ジェクトファイルおよびキャプチャーファイルフォルダが含まれます。保存されたプロジェクトを直

接公開することはできません。プロジェクトをエクスポートして、すべての構成をファイルにエクス

ポートし、構築されたプロジェクトを公開できます。 

図16 Projectディレクトリ 

 

ドロップダウンメニューから、Project > Exportをクリックします。 

1. 図17に示すように、ダイアログボックスが開きます。 

2. ファイルパスを指定し、Saveをクリックします。 

指定したディレクトリに.hclファイルが生成され、エクスポートされたプロジェクトが保存されま

す。 

hclファイルは共有できます。ユーザーは次の手順に従ってプロジェクトをインポートできます。 
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図17 プロジェクトのエクスポート 

 

 

注: 

プロジェクト名は最大20文字の文字列で、大文字と小文字は区別されません。有効

な文字は、文字、数字、およびアンダースコアです。 

編集 
 

図18は編集に使用可能なサブメニューを示しています。 

図18 サブメニューの編集 

 
 

仮想デバイス、テキスト、および図面を含むワークスペース上のすべてのオブジェクトを選択

するには、Select allを選択します。 

Unselect allを選択すると、すべてのオブジェクトの選択が解除されます。 

設定 
Settingsメニューの機能について詳しくは、｢HCLを設定する｣を参照してください。 
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閲覧する 

図19は、Viewで使用可能なサブメニューを示しています。 

図19 Viewサブメニュー 

 
 

ワークスペースには、仮想デバイス、テキストおよび図面などの複数の要素を含めることができ

ます。要素が重複する場合は、そのレイヤー値に従って配置されます。レイヤー値が最も大き

いものが優先度が最も高く、一番上に表示されます。右クリックメニューからSend Backward

およびBring forwardを選択すると、重複する要素のレイヤー値を配置できます。 

レイヤー値を表示するには、ドロップダウンメニューからView > Show layersをクリックします。

各エレメントに緑色のラベルが表示され、エレメントのレイヤー値が示されます。たとえば、図20

に示すように、DEV6のレイヤー値は1であり、重複する長方形のレイヤー値は0であるため、

DEV6は長方形の上に配置されます。 

レイヤーが表示されている場合は、ドロップダウンメニューからView>Hide layersの順に

クリックして、レイヤー値を非表示にできます。 

 

図20 階層要素 

 
 

注: 

仮想デバイスのレイヤー値の範囲は1～99であり、テキストおよび図面のレイヤー値の範囲

は¨C9～+99です。エレメントのレイヤー値が負の数値の場合、エレメントは移動できません。 

タイプの異なるオブジェクトには独自のデフォルトレイヤーがあります。 
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ヘルプ 

図21は、ヘルプで使用できるサブメニューを示しています。 

⚫ HCL helpは、HCLユーザーガイドを開きます。 

⚫ About HCLには、HCLの著作権が表示されます。 

⚫ About GNS3およびAbout Gqには、GNS3およびQTの著作権が表示されます。 

図21 Helpサブメニュー 

 
 

 

ログファイルファイルの収集 

ドロップダウンメニューからPack logをクリックします。HCLはログ情報の収集を開始し、ディレクトリ

C:\Users\username\HCLのLog file.zipファイルに保存します。 

終了 

ドロップダウンメニューからQuitをクリックして、HCLを終了します。 
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ショートカットアイコンバー 

この章では、ショートカットアイコンバーの手順を説明します。この章の内容は次のとおりで

す。 

⚫ プロジェクトの操作アイコン  

⚫ コントロールアイコンの表示  

⚫ デバイスコントロールアイコン  

⚫ 描画ツールアイコン  

⚫ 高度なツールアイコン  

図22に示すように、ショートカットアイコンバーには、一般的な操作を実行するためのショート

カットアイコンが表示されます。関連するアイコンはグループ化され、セパレータバーで区切ら

れています。ショートカットアイコンバーには、左から右に次のグループが表示されます。 

⚫ プロジェクトの操作アイコン。 

⚫ コントロールアイコンを表示します。 

⚫ デバイスコントロールアイコン。 

⚫ 描画ツールアイコン。 

⚫ 高度なツールアイコン。 

アイコンの上にカーソルを置くと、アイコンの機能を表示できます。 

図22 ショートカットアイコンバー 
 

 
 
 

プロジェクトの操作アイコン 
図23はプロジェクトの操作アイコンを示しています。このアイコンを使用して、新規プロジェクトの作成、

プロジェクトのオープン、プロジェクトの保存、およびプロジェクトのエクスポートを行うことができます。 

これらのアイコンの詳細については、「プロジェクト」を参照してください。 

図23 プロジェクトの操作アイコン 
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コントロールアイコンを表示する 
図24は、ワークスペース内のエレメントの表示/非表示ステータスを制御する表示制御アイコンを

示しています。 

図24 コントロールアイコンの表示 

 

最初の3つのアイコンは、デバイス名、インタフェース名、およびグリッドを表示/非表示にするため

のものです。枠付きアイコンは、要素が表示されていることを示します。 

最後の2つのアイコンは、ワークスペースを拡大または縮小するためのものです。 

デバイスコントロールアイコン 
図25は、デバイス制御アイコンを示しています。このアイコンを使用すると、すべてのデバイスを

開始および停止できます。 

図25 デバイス・コントロールのアイコン 

 

描画ツールのアイコン 
図26に、描画ツールアイコンを示します。テキストの追加、長方形および楕円の描画、およびワー

クスペースのスナップショットを作成できます。ワークスペースでテキストまたはファイルを表示また

は非表示にして、ワークスペース上の任意の位置にドラッグできます。 

図26 描画ツールのアイコン 
 

  



HCL-24 
 

テキストを追加する 
1. ショートカットアイコンバーのAdd textをクリックします。 

2. ワークスペースの空白領域をクリックすると、テキストを入力できるテキストボッ

クスが作成されます。 

3. テキスト領域を右クリックします。右クリックメニューを図27に示します。 

図27 右クリックメニュー 

 
次に、右クリックメニューの項目について説明します。 

⚫ Style： 文字スタイルを設定できます。 

⚫ テキストの色を設定するにはtext colorを選択します。 

⚫ フォントを選択してテキストのフォントを設定します。 

⚫ テキストボックスの回転角度を設定します。 

⚫ Duplicate： 選択したテキストをコピーできます。 

⚫ Delete： 選択したテキストを削除できます。 

⚫ Send backward： テキストボックスを1つ後ろのレイヤーに移動できます。 

⚫ Bring forward： テキストボックスを1つ上の画層に移動できます。 
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図28 スタイルの設定 

 
 

長方形を描画する 
1. ショートカットアイコンバーのDrawing Rectangleアイコンをクリックします。 

2. ワークスペースの空白の領域をクリックします。 長方形が作成されます。 長方形の描画をエスケー

プするには、Escキーを押すか、ワークスペース上の長方形の外側の位置をクリックします。 

3. 長方形を右クリックします。 右クリックメニューを図27に示します。このメニューの詳細については、

「テキストの追加」を参照してください。 

4. 右クリックメニューからStyleを選択します。 図29に示すように、ダイアログボックスが開きます。 

図29 スタイルの設定 
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次に、スタイル設定について説明します。 

⚫ Select fill color： 長方形の背景色を設定します。 

⚫ Select border color： 枠線の色を設定します。 

⚫ Border width： 罫線の線幅を設定します。 

⚫ Border style： 罫線の線のスタイルを設定します。 

⚫ Rotation angle： 四角形の回転角度を設定します。 

 

楕円を描画する 
操作は、「長方形の描画」で説明されている長方形の描画操作に似ています。 

 

ワークスペースのスナップショットをと

る 
ショートカットアイコンバーのSnapshot workspaceアイコンをクリックします。指定したディレクトリの

下にスナップショットが作成されます。 

高度なツールアイコン 
図30は、高度なツールアイコンを示しています。 

図30 高度なツールのアイコン 

 
 

One-Click Repair: 一般的な問題が発生した場合は、この機能を使用して対処します。 

装置が起動できないよう場合、ここをクリックして修復を試してください。 

Version updates： HCLソフトウェアのバージョンを更新します。 

Settings： 設定の詳細については、「HCLの設定」を参照してください。 

Command lookup tool： コマンド検索ツールを開きます。 

Help: HCLユーザーガイドを開きます。 

WeChat link: H3C UniversityのアカウントにリンクするためのQRコードを表示します。 

User forum: H3Cユーザーフォーラムを開きます。 
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装置とリンク領域 
この章では、デバイスおよびリンク領域の使用方法について説明します。 

この章は次の項で構成されています。 

⚫ DIYデバイス 

⚫ ルーター 

⚫ スイッチ 

⚫ ファイアウォール 

⚫ 無線デバイス 

⚫ エンドデバイス 

⚫ リンク 

図31に示すように、デバイスとリンクの領域には、さまざまなタイプのデバイス(DIYデバイス、ルー

ター、スイッチ、ファイルfirewalls、およびエンドデバイス)とリンクが表示されます。 

デバイスの追加方法については、「デバイスの追加」を参照してください。 

図31 デバイスとリンクの領域 
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DIYデバイス 
DIYデバイスアイコンをクリックすると、図48に示すように、DIYデバイスタイプリストが開きます。

 
 

図32 DIYデバイス 
 

 

リストの「DIYデバイスタイプtest、test1およびtest2は、作成されたDIYデバイスタイプです。

当初、HCLにはDIYデバイスタイプはありません。 

DIYデバイスタイプを作成する手順は、次のとおりです。 

1. DIY deviceアイコンをクリックします。 

DIYデバイスタイプを作成するウィンドウが開きます。図33に示すように、DIYデバイスタイプ

を作成するウィンドウには、インタフェース編集領域、インタフェース選択領域、デバイスタイ

プ操作領域およびデバイスタイプリスト領域が含まれます。 

2. デバイスタイプ操作領域にデバイスタイプ名を入力します。 

デバイスタイプ名には最大8文字を使用できます。有効な文字には、文字、数字およびア

ンダースコア(_)があります。無効な文字および余分な文字は自動的に無視されます。 

3. インタフェース編集領域にインタフェースを追加します。 

同じタイプのインタフェースを連続して追加するには、インタフェース選択領域でイン

タフェースタイプをクリックし、次にインタフェース編集領域でターゲット位置をクリック

します。インタフェースの追加を停止するには、インタフェース編集領域の任意のス

ペースを右クリックします。 

インタフェースを1つだけ追加するには、インタフェースタイプをインタフェース編集領

域のターゲット位置にドラッグ&ドロップします。 

インタフェース編集領域からインタフェースを削除するには、インタフェースを右クリックしま

す。 

4. デバイスタイプをロードし、そのデバイスタイプのインタフェースをインタフェース編集領域

に表示するには、デバイスタイプ領域でデバイスタイプを選択して、Loadをクリックします。 

デバイスタイプを削除するには、デバイスタイプを選択してDeleteをクリックします。 
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図33 DIYデバイスタイプ 
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ルーター 
図34に示すように、アイコンをクリックすると、図50に示すように、ルータータイプリストが開きます。現

在のソフトウェアバージョンでは、HCLはMSR36-20のみをサポートしています。 

図34 ルーター 

 

スイッチ 
デバイスおよびリンク領域でスイッチアイコンをクリックすると、図35に示すように、スイッチタイプリ

ストが開きます。現在のソフトウェアバージョンでは、HCLはS5820V2-54QS-GEのみをサポートし

ています。 

図35 スイッチ 

 
 

ファイアウォール 
図52に示すように、firewallアイコンをクリックすると、図36に示すように、ファイルfirewallタイプのリス

トが開きます。現在のソフトウェアバージョンでは、HCLはF1060のみをサポートしています。 

図36 ファイアウォール 

 
 



HCL-31 
 

無線 
無線コントローラ（AC）はWX5540Hという4ポートの10Gと23ポートの1Gポートをもつ装置です。 

無線アクセスポイントはWA6320-HCLというWA6320相当の機能を持つHCL用の装置です。HCLで

はアクセスポイントはFIT APのみでAnchorやCloudAPのモードで動かすことはできません。この仮想

APでは直接スイッチのポートに接続するだけで動作しますので、PoE装置を中間に接続する必要は

ありません。 

図 無線デバイス 

 
 

図 無線装置の利用例 
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図 Profileタブでプロジェクトの解説(図を含む)を作成 

 
 
 
図 Profileに図を読み込んだもの 
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図 Configurationタブでコンフィグを表示 

 
 

図 Fileタブでコンフィグファイルをエディターで開く 
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エンドデバイス 
デバイスおよびリンク領域でエンドデバイスアイコンをクリックすると、図37に示すように、エンドデバイ

スタイプリストが開きます。 

使用可能なエンドデバイスタイプには、ホスト(ローカルPC)、PC(仮想PC)、VPCS、リモートネットワー

クプロキシ(リモートPC上で実行されるネットワーク)、Cloud、Sever、Server2、Phoneが含まれます。 

図37 エンドデバイス 
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Host(ローカルPC) 
ローカルPCとは、HCLを実行しているPCのことです。ローカルPCをワークスペースに追加すると、PC

は仮想ネットワーク内のホストに仮想化されます。図38に示すように、ワークスペース上のホストの

NICはローカルPCのNICと同じです。ローカルPCは、ホストのNICを仮想デバイスのインタフェースに

接続すると、仮想ネットワークと通信できます。通常、NIC:VirtualBox Host-Only Ethernet Adapterが

使われます。 

図38 ホストのNIC 
 

 

下図がVirtualBox Host-Only Ethernet Adapterに標準的に割り当てられているIPアドレス。 
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PC(仮想PC) 
仮想PCとは、PCの機能をシミュレートするためにHCLによって実行されるデバイスのことで

す。仮想PCは、ワークスペースに仮想PCを追加した後にシミュレートされます。仮想PCは起

動せずにデバイスに接続できます。 

仮想PCの起動後、仮想PCを右クリックし、ショートカットメニューからConfigureを選択します。

図39に示すように、仮想PCの構成ウィンドウが開きます。このウィンドウでは、インタフェース

を有効または無効にして、インタフェースのIPv4アドレス、IPv6アドレスおよびゲートウェイを

手動またはDHCPを使用して構成できます。 

 

注: 

仮想PCの構成ウィンドウを開くには、仮想PCが完全に起動するまで待ちます。次に、

仮想PCを右クリックし、ショートカットメニューからConfigureを選択します。仮想PC

が完全に起動していない場合は、Failed to connect to the device. Please try 

again.というメッセージが表示されます。 

 

図39 仮想PCの構成ウィンドウ 
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VPCS (Virtual PC Simulator） 
 

コマンドラインを入力し、「show ip」コマンドでIPアドレスを表示します。VPCSデバイスを設定

するには、コマンドラインターミナルを使用することをお勧めします。このページでIPを設定す

るとVPCSデバイスが再起動しますので、設定を保存するように注意してください。 
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VPCSでのコマンド例： 
ip 192.168.56.100/24 192.168.56.1 
ping 192.168.56.1 
show ip 
trace 192.168.1.2 
show arp 
dhcp 
ip dns 8.8.8.8 
set pcname HOME 

 

Remote(リモート仮想ネットワークプロ

キシ) 
 

重要 

仮想ネットワークを正しく接続するには、仮想ネットワークが存在するPCが同じネッ

トワーク内にあり、互いに通信できることを確認します。 

 

リモート仮想ネットワークプロキシ(以下、ネットワークプロキシと称す)は、ローカルPC上の仮

想ネットワークとリモートPC上の仮想ネットワークとの間に通信トンネルを確立するため(異な

るPC上で動作するHCL同士の通信)に使用される。 

ネットワークプロキシを使用して仮想ネットワーク間にトンネルを確立するには、次の手順を

実行します。 

1. 各エンドにネットワークプロキシを追加します。 

図37に示すように、各PCの仮想ネットワークにネットワークプロキシを追加する必要

があります。ネットワークプロキシはリモートの仮想ネットワークを表します。 

2. 両端を互いのピアとして指定します。 

a. 停止しているネットワークプロキシをダブルクリックします。図40に示すページが開きます。 

b. ページで、リモートネットワークが存在するPCのIPアドレスとリモート仮想ネットワークのプ

ロジェクト名を入力します。これら2つのパラメータにより、接続するリモートネットワークが

一意に識別されます。 
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図40 ネットワークプロキシの構成 

 
 

3. 通信トンネルを確立するめに、両端でネゴシエーションを行います。 

a. ネットワークプロキシを右クリックし、Add linksを選択します。 

図41に示すように、トンネル構成ウィンドウが開きます。 

b. トンネルの名前を入力します。 

2つのネットワークプロキシのトンネルに同じ名前を入力します。トンネル名には最大20文

字を使用できます。有効な文字は、文字、数字およびアンダースコア(_)です。無効な文字

および余分な文字は自動的に無視されます。 

同じトンネル名を使用して、2つの仮想ネットワークを接続するデバイスインタフ

ェースを識別できます。 

図41 トンネルの構成 
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Cloud 
 

クラウドデバイスは、現在のプロジェクトをさまざまなデバイスやGNS3(Cisco IOSをPC上でエミュレ

ートする)などの他のネットワークシミュレータに接続するために使用できる。クラウドデバイスは、

UDPチャネルを使用して他のプロジェクトに接続する。 

  

  注: 

·デバイス間でクラウド相互接続を使用するには、デバイスが相互に通信できる必要があり、ファイ

アウォールを無効にする必要があります。 

  

1. Cloudの利用例 
デバイス Aの IP:10.153.46.11 

デバイス Bの IP:10.153.46.12 

デバイスAとBは相互に通信できます。 

デバイスAによるクラウドの構成例: 

 

図 デバイスA 
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デバイスBによるクラウドの構成例: 

図 デバイスB 

 
 

デバイスAのMSRの設定と相互接続の確認: 

図 DeviceA-MSR 
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2. GNS3によるクラウド接続例 
HCLでのクラウドのローカル環境設定 

図 HCL 

 
 

GNS3におけるクラウドのローカル環境構成 

図 GNS3 
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HCLでのMSRの設定と相互接続の確認: 

図 DeviceA-MSR 

 
 

GNS3におけるc3725の構成と相互接続の検証 

図 GNS3-c3725 
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Server 
このサーバーはAlpine Linux 3.14ベースのものです。ログインアカウントは 

User: root 

Password: 123456 

 

 

Welcome to Alpine Linux 3.14 

Kernel 5.10.61-0-virt on an x86_64 (/dev/ttyS0) 

 

localhost login: root 

Password:123456 

Welcome to Alpine! 

The Alpine Wiki contains a large amount of how-to guides and general 

information about administrating Alpine systems. 

See <http://wiki.alpinelinux.org/>. 

You can setup the system with the command: setup-alpine 

You may change this message by editing /etc/motd. 

localhost:~# 

 

Linuxコマンドで各種のサーバーを仮想上で構築できます。 
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Server2 
このサーバーはLinux上に便利なツールを詰め込んだBusyBox v1.35.0のインストールしたもので

す。 

ログインアカウントは 

User: root 

Password: 123456 

 

 

サーバーにアクセスするにはアイコンを右クリックしてメニューのConfigureを選択し

ます。 
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Configureを選択すると自動的のブラウザーが開いてメニューから機能を選択できます。 

ログインウインドウに先ほどのユーザー名とパスワードを入力します。 

 

 
 
ウインドウ表示されたメニューで分かるように、ターミナル, TFTPサーバー, FTPサーバー, 

DHCPサーバー,DNSサーバー,RADIUSサーバー,Multicastサーバー,Client, Log Server

などの機能を仮想上で稼働させることができます。 
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Phone 
 

Phoneは無線クライアントとして、仮想アクセスポイントから送信されるSSIDを選択

して接続します。通常、IPは無線コントローラまたは、PoEスイッチにDHCPサーバ

ーの機能を有効にして、接続したSSIDを経由してこれらのDHCPサーバーからIPア

ドレスを取得することができます。 
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リンク 
図42に示すように、リンク・アイコンをクリックするとリンクタイプリストが表示されます。表3

にリンクタイプを示します。 

図42 リンクタイプリスト 

 

表3 リンクタイプ 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Manualを選択すると、手動でリンクを追加するモードになります。このモードでは、リンク

の追加時にインタフェースを手動で選択する必要があります。 

manual以外のリンクタイプを選択すると、自動的にリンクを追加するモードになります。

このモードでは、リンクタイプに基づいてインタフェースが自動的に選択されます。 

追加されたリンクの色は、図58に示すようにリンクタイプの色と同じです。 

リンクの追加を停止するには、ワークスペースの任意の場所を右クリックします。リンクの

追加の詳細は、次を参照してください。 

タイプ 説明 

manual 手動でリンクを追加するには、このタイプを選

択します。 

ギガビットイーサネット GEインタフェースを接続します。 

10ギガビットイーサネット 10-GEインタフェースを接続します。 

40ギガビットイーサネット FGE(40-GE)インタフェースを接続します。 

シリアル シリアルインタフェースを接続します。 

POS POSインタフェースを接続します。 

E1 E1インタフェースを接続します。 

ATM ATMインタフェースを接続します。 
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「リンクの追加」 
 

注: 

1台のデバイスに最大7つのリンクを追加できます 
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ワークスペース 

この章では、ワークスペースの使用方法について説明します。この章の内容は次のとおりです。 

⚫ アイコン 

⚫ 操作装置 

⚫ リンクの追加 

⚫ パケットのキャプチャー 

⚫ その他の事業  

ワークスペースは図43のようになります。ワークスペースでは、デバイス、リンク、およびシェイプを

追加することによって仮想ネットワークを確立できます。 

図43 ワークスペース 
 

アイコン 
ワークスペース上のデバイスタイプを区別すために、HCLでは異なるアイコンを使用して異なルー

ターイプのデバイスを表します。図44に示すアイコンは、DIYデバイス、ルーター、スイッチ、ローカ

ルPC、リモートネットワークプロキシ、firewallsおよび仮想PCを順番に表しています。 

停止したデバイスの内部イメージは白で表示されます(例:MSR36-20_1およびRemote_1)。

実行中のデバイスの内部イメージは緑で表示されます(例:DIY-TEST_1およびHost_1)。選

択したデバイスの背景は青で表示されます(例:S5820V2-54QS-GE_3)。選択していないデ

バイスの背景は黒です。 
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図44 デバイスのアイコン 

 
 

デバイスに関する詳細情報を表示するには、図45に示すように、デバイスアイコンの上にカーソル

を置きます。 

図45 デバイスアイコンの上にマウスポインタを置く 
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操作装置 
ワークスペースで、デバイスを右クリックします。ショートカットメニューからアイテムを選択

してデバイスを操作します。停止したデバイスのショートカットメニューは図46に示されてい

ます。 

実行中の装置のショートカットメニューは、図47に示すとおりです。 

図46 停止したデバイスのショートカットメニュー 

 

図47 実行中のデバイスのショートカットメニュー 
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ショートカットメニューには、次の項目があります。 

Start/Stop： 停止したデバイスの場合は、Startを選択します。 

デバイスを起動します。実行中のデバイスの場合は、Stopを選択します。 

デバイスを停止します。 

Configure：Configureを選択して、デバイスを構成するためのダイアログボックスを開きま

す。たとえば、図48のようになります。 

MSR36-20ルーターを設定するためのダイアログボックスを示します。ダイアログボックスで

Device Infoをクリックして、デバイスの詳細を説明するWebページを入力します。メモリコン

トロールバーを移動して、デバイスのメモリサイズを調整します 

図48 MSR36-20ルーターの設定 

 

Start CLI： 実行中のデバイスに対してStart CLIを選択すると、図65に示すような

CLIが開きます。 

CLIでコマンドを入力してデバイスを構成し、デバイス情報を表示できます。また、実行中の

デバイスをダブルクリックしてCLIを開くこともできます。 

 

注: 

ホストまたはリモートネットワークプロキシのCLIは起動できません。 

装置のCLIを開始するには、装置が開始していることを確認してください。 
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図49 CLI 

 

Add Links： ショートカットメニューからAdd Linksを選択して、手動でリンクを追加

するモードを入力します。 

このモードでは、デバイスをクリックし、ソースインタフェースを選択してから、リンクを追加

する宛先インタフェースを選択します。リンクの追加の詳細は、「リンクの追加」を参照してく

ださい。 

Rename： ショートカットメニューからRenameを選択します。図50に示すダイアログボ

ックスが開きます。 

ダイアログボックスで、デバイス名を入力しOKをクリック。 

注: 

実行中のDIYデバイス、ルーター、スイッチ、またはfirewallの名前は変更できません。 

装置名は最大20文字まで。 

 

図50 デバイスの名前の変更 

 
 

Delete： デバイスを削除するには、Deleteを選択します。 

Send Backward： Send Backwardを選択して、アイコンを1つ下のレイヤーに移動しま
す。 
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Bring forward： Bring forwardを選択すると、アイコンが1つ上のレイヤーに移動しま
す。 

 

リンクを追加する 
ワークスペースでは、次のリンク操作を実行できます。 

⚫ 手動でリンクを追加する 

⚫ 自動的にリンクを追加する  

⚫ リンクを削除する 

 

リンクを手動で追加する 
1. Add linksアイコンをクリックし、Devices and links領域でManualを選択します。 または、ワークス

ペースでデバイスを右クリックし、ショートカットメニューからAdd linksを選択します。 

2. リンクを追加するデバイスをクリックします。 

図51に示すようなインタフェース選択ウィンドウが開きます。 インタフェースの緑色のインジケータ

は、インタフェースが接続されたことを示します。 

3. インタフェースが接続されていないことを示す赤いインジケータが付いたインタフェースを選択しま

す。 

次に、別のデバイスのインタフェースを選択してリンクを追加します。 

4. リンク追加モードを終了するには、ワークスペースの任意のスペースを右クリックするか、ESCを押

します。 
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図51 リンクを手動で追加する場合のインタフェースの選択 

 

リンクを自動的に追加する 
1. Add linksアイコンをクリックし、devices and links領域でManual以外のリンクタイプを選択します。 

2. リンクを追加するデバイスをクリックしてから、別のデバイスをクリックしてリンクを追加します。 

3. リンク追加モードを終了するには、ワークスペースの任意のスペースを右クリックします。 

リンクを削除する 
リンクを削除するには、リンクを右クリックし、Deleteを選択します。 

 

パケットのキャプチャー 
デバイス間にリンクを追加した後、インタフェース上のパケットをキャプチャーできます。 

キャプチャーを開始するには 

1. 図52に示すように、リンクを右クリックして、ショートカットメニューからStart capturingを選択

します。 

図53に示すように、パケットをキャプチャーするためのウィンドウが開きます。 
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図52 キャプチャーの開始 

 

図53 取得インタフェースの選択 

2. ウィンドウで、キャプチャーインタフェースを選択します。OKをクリックしてパケットのキャプチャー

を開始します。 

選択したインタフェースがキャプチャーインタフェースリストに表示されます。 

Wiresharkを起動するには 

リンクを右クリックし、図54に示すように、ショートカットメニューからStart Wiresharkを選択し

ます。次に、Wiresharkを使用して、キャプチャーされたパケットを分析できます。 

図54 Wiresharkの起動 

 

注: 

開始後、Wiresharkはパケットを自動的にリフレッシュしません。デフォルトでは、

Wiresharkが開始される前にキャプチャーされたパケットのみが表示されます。

Wiresharkの後にキャプチャーされたパケットを表示するには、Wireshark上でリフ

レッシュアイコン       をクリックします。 

 

キャプチャーを停止するには 

パケットがキャプチャーされているリンクを右クリックし、図74に示すように、ショートカットメニ

ューからStop capturingを選択します。 

キャプチャーファイルをエクスポートするには 

リンクを右クリックし、ショートカットメニューからExport capture fileを選択して、キャプチャ

ーされたパケットを特定のフォルダにエクスポートします。 
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その他の操作 
ワークスペースでは、次の操作も実行できます。 

ワークスペース上のエレメントの移動 

エレメントとは、ワークスペース上のデバイス、イメージ、および注記をまとめて指します。エレメ

ントを移動するには、エレメントをクリックしてターゲット位置にドラッグします。この操作により、

複雑なネットワーク図がより明確になります。 

ワークスペース上のエレメントの位置合わせ 

複数のエレメントを選択して右クリックし、選択したエレメントを位置合わせするショートカットメニュ

ーからAlign horizontallyまたはAlign verticallyを選択します。 

ワークスペースのサイズを調整する 

ワークスペースと右側のキャプチャーインタフェースリスト領域の間にあるスペースバーをドラッ

グして、ワークスペースとキャプチャーインタフェースリストの表示比率を調整できます。 

パーソナルセンター 

この章では、パーソナルセンターの使用方法について説明します。 

一部のHCL機能(デバイスソフトウェアバージョンの変更やHCLのアップグレードなど)は、ロ

グインしているユーザーだけが使用できます。 

ログインするには: 

1. パーソナルセンターエリアのPersonal Centerアイコンをクリックします 

図55パーソナルセンター 

 

2. 開いたユーザーログインウィンドウで、ユーザータイプを選択し、OKをクリックします。 

図56 ユーザータイプの選択 
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3. ユーザー名、パスワード、確認コードを入力し、Loginをクリックします。 

注: 

ユーザーログインウィンドウでユーザータイプを変更する場合は、Change user

をクリックします。 

 

図57 ユーザーログインウィンドウ 

 

4. ログインに成功したら、Personal Centerアイコンをクリックします。 

図58に示すページが開きます。 
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図58 ユーザー関数ウィンドウ 

 

このページには、次のボタンがあります。 

Earn bonas： 毎日のボーナスを稼ぐには、このボタンをクリックします。 

Messages： HCLによってプッシュされたメッセージを表示するには、このボタンをクリック
します。 

Official site： このボタンをクリックすると、最新のH3Cウェブサイトにアクセスできます。 

Feed back： このボタンをクリックすると、HCLに関する問題がフィードバックされます。 

My info： このボタンをクリックしてMy infoを入力します。 

ページが表示されます。ページで情報を編集できます。 

Log out： ログアウトするには、このボタンをクリックします。 
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キャプチャーインタフェースリスト 

この章では、キャプチャーインタフェースのリスト領域の使用方法について説明します。 

キャプチャーインタフェースリストには、パケットキャプチャーが構成されたすべてのインタフェースが表

示されます。図59に示すように、リストには次の列があります。 

Device running status： 赤色のインジケータはデバイスが停止していることを示
し、緑色のインジケータはデバイスが停止していることを示します。 

インジケータは、デバイスが実行中であることを示します。実行中のデバイスでのみパケットをキ

ャプチャーできます。 

Device name： パケットキャプチャー設定インタフェースが存在するデバイスの名前。 

Interface name： パケットキャプチャーが設定されているインタフェースの名前。 

図59 Captureインタフェースリスト 

 

リストの項目を右クリックします。表示されるショートカットメニューでは、すべてのキャプチャータスクの

停止、インタフェースでのキャプチャーの停止、Wiresharkの起動、またはディレクトリへのキャプチャ

ーファイルのエクスポートを選択できます。 
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トポロジーサマリー領域 

この章では、トポロジーサマリー領域の使用方法について説明します。 

この章は次の項で構成されています。 

⚫ インタフェースリンクの拡張または縮小 

⚫ 装置操作 

⚫ 操作リンク 

トポロジーサマリエリアには、図60に示すように、すべてのデバイスの実行ステータスおよびインタフェ

ース間のリンクが表示されます。このエリア内のデバイスに対していくつかの操作を実行することもで

きます。 

領域の右上隅にある二重三角形のアイコンをクリックするか、領域の上のグレーのバーをダブルクリッ

クして、トポロジーサマリー領域を表示または非表示にします。 

図60 トポロジーの概要領域 
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インタフェースリンクの拡張又は縮小 
トポロジーサマリー領域のインタフェースリンクを拡張または集約します。 

単一のデバイスのインタフェースリンクを展開または縮小するには、デバイス名をダブルクリックする

か、左の三角形のアイコンをクリックします。 

すべてのデバイスのインタフェースリンクを展開または縮小するには、トポロジーサマリー領域を右ク

リックし、Expand allまたはCollapse allを選択します。 

装置操作 
デバイス名を右クリックします。表示されるショートカットメニューから、デバイスの構成、開始、停止、

削除、またはワークスペース上のノードの検索を選択できます(図61および図62を参照)。 

図61 装置の操作 
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図62 装置の操作 
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リンクの操作 

リンクを右クリックします。表示されるショートカットメニューで、図63に示すように、キャプチャーの開始、

キャプチャーの停止、Wiresharkの起動、リンクのキャプチャーファイルのエクスポート、リンクの削除

を選択できます。 

図63 リンクの操作 
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HCLネットワーク構成の例 

この章では以下のHCLネットワークコンフィギュレーションの例を提供します： 

例１: 同じホスト上の2つの仮想デバイスを使用してネットワークを確立する 

例２: ホスト上の仮想デバイスのホストへの接続 

例３: ホスト上の仮想デバイスをホストを介して物理デバイスに接続する 

例４: 異なるホスト上の2つの仮想デバイスを使用したネットワークの確立 
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例１:同じホスト上の2つの仮想デバイスを使

用してネットワークを確立する 

ネットワーク構成 
図64に示すように、同じホスト上に2つのMSR36デバイスを追加し、それらの間にリンクを追加し

てネットワークを確立します。 

図64ネットワーク図 
 

手順 

1. デバイスを追加します。 

2つのMSR36デバイスを作業領域に追加します。デバイスの追加の詳細は、「デバイスの追加」を参

照してください。 

2. デバイス間のリンクを追加します。 

a. デバイスMSR36-20_1を右クリックして右クリックメニューからAdd 

linksをクリックします。 

カーソルがクロス記号に変わります。 

b. デバイスMSR36-20_1をクリックして、GE_0/0を選択します。 

リストから選択します。 

c. デバイスMSR36-20_2をクリックして、GE_0/0を選択します。 

リストから選択します。 

d. ワークスペースの空きスペースを右クリックします。 

カーソルが元に戻ります。 

リンクの追加の詳細については、「リンクの追加」を参照してください。 

3. デバイスを起動します。 

2つのデバイスを選択し、いずれかのデバイスを右クリックして、右クリックメニューからStartを選択し

ます。 

構成の検証 

1. 各デバイスをダブルクリックするか、各デバイスを右クリックして、右クリックメニューからStart CLIを

選択し、CLIにログインします。 
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2. 同じサブネット上のIPアドレスを接続されたインタフェースに割り当てます。 （詳細は省略） 

3. pingコマンドを使用して、デバイス間の接続を確認します。 （詳細は省略） 
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例２:ホスト上の仮想デバイスのホストへの

接続 

ネットワーク構成 
図 65に示すよ うに 、 MSR36デバイス と ホス ト を追加 します 。 MSR36デバイスの

GigabitEthernet0/0をホストのVirtualBox Host-Only NICに接続し、PCからMSR36デバイスに

Telnet接続できるようにします。 

図65 ネットワーク図 

 

 

手順 

1. デバイスとホストを追加します。 

a. MSR36デバイスをワークスペースに追加します。 

b. ワークスペースにホストを追加します。 

デバイスの追加について詳しくは、「デバイスの追加」を参照してください。 

2. デバイスとホスト間のリンクを追加します。 

a. デバイスMSR36-20_1を右クリックして右クリックメニューからAdd linksを

選択します。カーソルがクロス記号に変わります。 

b. デバイスMSR36-20_1をクリックして、GE_0/0を選択します。 

リストから選択します。 

c. 装置Host_1をクリックし、ポップアップNICリストからNIC:VirtualBox Host-Only 

Ethernet Adapterを選択します。 

d. ワークスペースの何もないスペースを右クリックします。カーソルが元に

戻ります。 

リンクの追加の詳細については、「リンクの追加」を参照してください。 

3. デバイスを起動します。 

デバイスMSR36-20_1を右クリックし、Startを選択します。 

ボタンをクリックします。 

構成の検証 
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1. デバイスMSR36-20_1をダブルクリックするか、デバイスを右クリックして、右クリックメニューから

Start CLIを選択し、CLIにログインします。 

2. IPアドレスをGigabitEthernet0 / 0に割り当てます。 

IPアドレスがホストのNICのIPアドレスと同じサブネットに属していることを確認してください。 （詳

細は表示されていません） 

3. デバイスMSR36-20_1にTelnetログインを設定します。 

<Sysname> system view 

[Sysname] line vty 0 4 

[Sysname-line-vty0-4] authentication-mode none 

[Sysname-line-vty0-4] user-role network-admin 

[Sysname-line-vty0-4] quit 

[Sysname] telnet server enable 

4. PCで、Telnetを起動し、MSR36-20_1のGigabitEthernet0 / 0のIPアドレスとポート番号23を

入力します。 

デバイスMSR36-20_1のCLIにログインしています。 
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例３:ホスト上の仮想デバイスを、ホストを

介して物理デバイスに接続する 

ネットワーク構成 
図66に示すように、MSR36デバイスとホストを追加します。MSR36デバイスと物理ルーターの両方を

ホストのInter(R)82579LM Gigabit Network Connection NICに接続して、2台のルーター間の接

続を確立します。 

図66 ネットワーク図 

 

 

制限事項およびガイドライン 
ホストにはイーサネットインタフェースのみがあります。MSR36デバイス上のイーサネットインタフ

ェースのみを使用して物理デバイスに接続できます。 

手順 

1. デバイスとホストを追加します。 

a. MSR36デバイスをワークスペースに追加します。 

b. ワークスペースにホストを追加します。 

デバイスの追加について詳しくは、「デバイスの追加」を参照してください。 

2. デバイスとホスト間のリンクを追加します。 

a. デバイスMSR36-20_1を右クリックして右クリックメニューからリンクを追加

します。カーソルがクロス記号に変わります。 

b. デバイスMSR36-20_1をクリックして、GE_0/0を選択します。 

リストから選択します。 
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c. デバイスHost_1をクリックし、ポップアップNICリストからInter(R)82579LM Gigabit 

Network Connectionを選択します。 

d. 作業現場の何もないスペースを右クリックします。カーソルが元に戻ります。 

リンクの追加の詳細については、"リンクを追加する。"を参照してください。 

3. ホストをルーターに接続します。 

ネットワークケーブルを使用して、NIC Inter(R)82579LMギガビット 

ットワーク接続を物理デバイスRouterA上のGigabitEthernet0/0に 

続します。 

4. デバイスを起動します。 

a. デバイスMSR36-20_1を右クリックして右クリックメニューから開始します。 

b. 物理デバイスRouterAをオンにします。 

構成の検証 
1. 物理ルーターにログインし、IPアドレスをGigabitEthernet0/0に割り当てます。 （詳細は表示されてい

ません） 

詳細については、Comware7構成ガイドを参照してください。 

2. デバイスMSR36-20_1をダブルクリックするか、デバイスを右クリックして、右クリックメニューからStart 

CLIを選択し、CLIにログインします。 

3. IPアドレスをGigabitEthernet0/0に割り当てます。 

IPアドレスが物理ルーターのGigabitEthernet0/0のIPアドレスと同じサブネットに属していることを確

認してください。 （詳細は表示されていません） 

4. pingコマンドを使用して、デバイスMSR36-20_1と物理ルーター間の接続を確認します。 （詳細は表

示されていません） 
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例４:異なるホスト上の2つの仮想デバイスを使用した

ネットワークの確立 

ネットワーク構成 
図67および図68に示すように、次のタスクを完了します。 

PC1にProject1を作成し、MSR36デバイスとリモートPCを追加します。 

PC2上にProject2を作成し、MSR36デバイスとリモートPCを追加します。 

リモートネットワークプロキシを介してMSR36デバイスを接続します。 

図67 PC1上のProject1のネットワーク図 

 

図68 PC2上のProject2のネットワーク図 

 

 

手順 

1. デバイスを追加する 

a. PC1にProject1を作成し、PC2にProject2を作成します。 

b. Project1にMSR36デバイス(MSR36-20_1という名前)とリモートネットワークプ

ロキシ(Remote_1という名前)を追加します。Project2にMSR36デバイス

(MSR36-20_2という名前)とリモートネットワークプロキシ(Remote_2という名

前)を追加します。デバイスの追加の詳細は、「デバイスの追加」を参照してく

ださい。 

2. リモートネットワークプロキシを構成する 

a. PC1で、リモートネットワークプロキシRemote_1をダブルクリックし、PC2のIPア

ドレス(10.1.1.2)とリモートプロジェクト(Project2)の名前を入力します。 



HCL-75 
 

b. PC2で、リモートネットワークプロキシRemote_2をダブルクリックし、PC1のIPア

ドレス(10.1.1.1)とリモートプロジェクト(Project1)の名前を入力します。 

3. トンネルを設定します。 

a. PC1で、MSR36-20_1のGigabitEthernet0/0とRemote_1の間にリンクを追加し

ます。 

b. ポップアップダイアログボックスで、トンネル名を入力します。 

tunnel1を選択し、OKをクリックします。 

c. PC2では、MSR36-20_2のGigabitEthernet0/0とRemote_2間のリンクを追加

します。 

d. ポップアップダイアログボックスで、トンネル名を入力します。 

tunnel1を選択し、OKをクリックします。 

4. デバイスを起動します。 

MSR36-20_1、Remote_1、MSR36-20_2、およびRemote_2を起動します。 

構成の検証 
1. 各MSR36デバイスをダブルクリックするか、各MSR36デバイスを右クリックし、右クリックメニ

ューからStart CLIを選択してCLIにログインします。 

2. 同じサブネット上のIPアドレスを接続されたインタフェースに割り当てます。 （詳細は表示され

ていません。） 

3. pingコマンドを使用して、デバイス間の接続を確認します。 （詳細は表示されていません。） 
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HCLのインストール、設定、およびアンイン

ストール 

HCLのこのヘルプでは、インストールの操作、設定、およびアンインストールについて説明します。 

次のトピックが含まれています。 

⚫ ホスティングPCの要件 

⚫ HCLのインストール 

⚫ HCLの設定 

⚫ HCLのアンインストール 

ホスティングPCの要件 

HCLをホストPC上で円滑に実行するには、PCが次の要件を満たす必要があります。 

表2 ホスティングPCの要件 

項目 説明 

中央処理装置 周波数:1.2GHz 

コア数:2コアVT-xまたはAMD-Vをサポート 

メモリ 4GB 

ハードディスク 80GB 

オペレーティングシステム Windows7以降 
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HCLのインストール 

HCLインストールパッケージを入手したら、次の手順に従ってHCLをインストールします。 

1. インストレーションの準備 

2. インストールディレクトリーの選択 

3. インストールするコンポーネントの選択 

4. HCLインストールの開始 

5. HCLインストールの完了 

6. Windows8, 10, 11での動作環境の設定 

 
 

ヒント 

管理者としてHCLインストールプログラムを実行します。 
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インストールの準備 

1. 言語を選択したら図69に示すようにダイアログボックスが開き、図70に示すように、ライ

センス契約ダイアログボックスが表示されます。 

2. I accept the terms of the License Agreementを選択します。 

3. Nextをクリックします。 

図69 HCLインストールのようこそダイアログボックス 
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図70 ライセンス契約 

 

インストールディレクトリーの選択 

1. 図71に示すダイアログボックスが開きますので、インストールディレクトリーを選択します。 

デフォルトディレクトリーはC:\Program Files\HCLです。Browseをクリックして別のインストー

ルディレクトリーを選択できます。 

2. Nextをクリックします。 
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図71 インストールディレクトリーの選択 

 

インストールするコンポーネントの選択 

1. 図72で示すダイアログボックスでインストールするコンポーネントを選択します。ンポーネン

トH3C Cloud Labが必要です。HCLはVirtualBoxに基づいて実行されます。VirtualBox

がPCにインストールされていない場合は、VirtualBoxを選択します。 

2. Installをクリックします。 

注: 

・VirtualBoxのバージョンが6.0.14以上であることを確認してください。 PCが6.0.14より前のバージョン

を実行している場合は、VirtualBoxをアンインストールします。 

次に、HCLをインストールします。 バージョン5.10.3をお勧めします。 

・PCで実行されているVirtualBoxのバージョンが6.0.14以降の場合、コンポーネントの選択手順はスキッ

プされます。 

・VirtualBoxコンポーネントは、PCにインストールされていない場合、デフォルトで選択されています。 

・名前に英語以外の文字が含まれているディレクトリにVirtualBoxをインストールしないでください。 
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図72 インストールするコンポーネントの選択 

 

 

  



HCL-82 
 

HCLのインストールの開始 
図73に示すように、ダイアログボックスにインストールの進行状況が表示されます。 

図73 インストールの進行状況 
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HCLのインストールの完了 

インストールが完了すると、図74に示すようなダイアログボックスが開きます。Finishをクリックします。 

システムはインストールプロセスを終了します。デスクトップとHCLのスタートメニューにショートカットが

作成されます。 

図74 インストレーション完了 
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HCLの起動 
1. 管理者としてH3C Cloud Labを実行します。 

図75 管理者としてHCLを起動 

 
 

2. ネットワークへのアクセスを許可する(初回のみ警告が表示されます) 

図76 simwarewrapper.exe(HCLのモジュール) 
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図77 simwaremulticc.exe(HCLのモジュール) 

 
 

3. アプリケーションが起動されます。 

図78 起動後のＨＣＬアプリケーション画面 
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補足 
 初回起動時にアプリのアクセスを許可しなかった場合、後から許可する方法は以下の通り。 
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HCLの設定 
 

1. ショートカットアイコンバーのバーのSettingsアイコンをクリックするか、右上隅のMenuドロッ

プダウンリストからSettingsを選択します。 

図79に示すように、HCL設定ページが開きます。 

General、Tools、およびVersion設定ページを使用できます。Resetボタンは

現在のページにのみ適用されます。 

図79 一般設定 

 

一般的な設定 
図79に示すように、Generalページでは次の設定を実行できます。 

⚫ Language: HCLページの言語を設定します。英語と中国語に対応しています。 

⚫ 起動時にOpen Projectダイアログボックスを表示します： HCLの起動時に図9に示すようなダ

イアログボックスを開きます。このボックスは既定値がチェックされます。 

⚫ Project path： プロジェクトを保存するための既定のパスを設定します。既定のパスはシス

テムユーザーの下にあります。 

Browseをクリックすると、パス設定を変更できます。 
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ツールの設定 
HCLの操作に使用するツールを設定できます。 

⚫ Wireshark path: Wiresharkのインストールパスを設定します。パスが正しいこと

を確認してください。それ以外の場合はWiresharkでキャプチャーされたパケットを

表示することはできません。 

⚫ CLIウィンドウモード  

マルチウィンドウモード: 各デバイスに対して常に新しいウィンドウでCLIを実行します。 

シングルウィンドウモード: 各デバイスの新しいタブで常にCLIを実行します。 

図80 ツールの設定 

 

バージョン設定 
ソフトウェアバージョンを変更して、指定したモデルのデバイスで実行することができます。 

バージョンを変更するときは、これらの制限とガイドラインに従ってください。 

⚫ このページは、HCLにログインした後にのみ使用できます。 
⚫ デバイス上で実行されているバージョンよりも低いバージョンを作成した場合以前

のバージョンでサポートされていたものは失われます。 

⚫ ソフトウェアバージョンを変更する前に、指定したモデルのすべてのデバイスを停止
する必要があります。 
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図81 バージョンの設定 

 

HCLのアンインストール 
HCLをアンインストールする前に、HCLプログラムが実行されていないことを確認してくださ

い。 

HCLをアンインストールするには、次の手順を実行します。 

1. アンインストールディレクトリの確認 

2. アンインストールの完了 

 

ヒント 

管理者としてHCLアンインストールプログラムを実行します。  

  



HCL-92 
 

アンインストールディレクトリの確認 
1. 図82に示すダイアログボックスで、アンインストールディレクトリを確認します 

図82 アンインストールディレクトリの確認 

2. Uninstallをクリックします。 

図83に示すように、アンインストールプロセスが開始されます。 
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図83 アンインストールの進行状況 
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アンインストールの完了 
アンインストールが完了すると、図84に示すようなダイアログボックスが開きます。Finishをクリック

します。 

図84 アンインストールの完了 
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HCLの使用に関する制限およびガイドライ

ン 

⚫ ユーザーがHCLを正しく開始するには、ユーザー名にASCII文字のみが含まれていることを確認します。 

 

⚫ 管理者としてHCLを開始しないでください。管理者としてHCLを開始した場合デスクトップのHCLショートカッ
トアイコンをダブルクリックすると、HCLを起動できます。この問題を解決するには、PCを再起動する必要が
あります。 

 

⚫ HCLで仮想デバイスのリンクを追加および削除する操作を何度も繰り返した場合、一部のリンクが起動して
いません。この現象は、異なるホスト上のデバイスを使用してネットワークを確立する場合に発生する可能
性が高くなります。この問題を解決するには、デバイスを停止してから、再度デバイスを起動します。 

⚫ HCLインストールディレクトリー内のファイルを削除、移動、または変更しないでください。このルールに
従わない場合はHCLを正しく起動できない場合があります。 

⚫ firewallまたはアンチウイルスソフトウェアでパケットフィルタリングを有効にしないでください。 

⚫ ファイルまたはウイルス対策ソフトウェアを使用すると、仮想デバイスとそのホストまたはPC間の通

信が失敗する場合があります。firewallまたはウイルス対策ソフトウェアを使用すると、仮想デバイス

とそのホストまたはベストプラクティスとして、実行中の仮想デバイスの管理にはHCLのみを使用して

ください。 

⚫ デバイスを管理するVirtualBoxマネージャーとして(たとえば、NICのブリッジ、デバイスの開始または

停止など)、デバイスが正常に動作しない場合があります。 

 

⚫ Windowsホスト上で仮想デバイスを開始できない場合は、次のタスクを実行します。 

⚫ 問題を解決します。 

A) ユーザーカウント制御設定を開く 
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コンピューターに対する変更の通知を受け取るタイミングの選択の設定が「通知しない」

になっていることを確認します。 

 

 

B) 通常、HCL上の仮想デバイスのシステム時間は、ホストPCのシステム時間よりも遅くなります。 

 

C) VirtualBoxインストールディレクトリーの名前には、英文字のみを使用する必要があります。 

nameに他のタイプの文字が含まれているため、HCL上の仮想デバイスを開始できません。 

 

D) ベストプラクティスとして、ホストPCでVT-xまたはAMD-Vを有効にします。VT-xまたはAMD-Vを

有効にしない場合は、仮想HCL上のデバイスは低速で動作します。 

ホストPCでVT-xまたはAMD-Vが有効であるかどうかは、タスクマネージャーを開いてパフォー
マンスのタブを開いて、CPUを選択します。（有効にするかどうかはBIOSの画面で設定します） 

下のように仮想化： 有効と表示されていれば、仮想化が有効です。 
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⚫ HCLを開始するときに、メッセージが表示された場合は、VBoxSVCプロセスが実行中であるかどう
かを確認します。 

VirtualBox APIのステータスを確認するプロンプトが表示されます。プロセスが実行中でない場合は、

VirtualBoxを起動してから、プロセスのステータスを再度識別します。プロセスがまだ実行中でない

場合は、VirtualBoxを再インストールします。VirtualBoxのインストールの詳細は、「インストールす

るコンポーネントの選択」を参照してください。 
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HCLの仕様に関する制約事項 
 

1. HCLはどのようなデバイスをサポートしていますか？ 
HCLV5.10.1の正式版では、MSR3620デバイス、VSR88デバイス、S5820V2-54QS-GEデバイス、

S6850デバイス、F1060デバイス、F1090デバイス、AC、APをサポートしています。 

 

2. HCLでサポートされていない機能は何ですか？ 
現在のバージョンでは、以下の機能はサポートされていません。 

スイッチング製品：ポートアイソレーション、トラフィック統計、Netconf。 

セキュリティ製品：IRFデュアルマシンホットスタンバイ。 

ルーティング製品：ADWAN関連機能、SR、SRv6、FlexE、Netconf。 

 

3. HCLでQoSアクセス制御が機能しないのはなぜですか？ 
この問題はQoSだけでなく、QoS、MQC、ACLカウント統計、スーパーVLANのARPプロキシ、

isolate-user-vlan、ポートアイソレーションなど、ハードウェアチップによる実装を必要とする機能は、

HCLシミュレータでは実現できません。 

 

注：スーパーVLAN関連の実験を行うには、デバイスをb59バージョン（デフォルトはb75バージョン）

に切り替える必要があります。デバイスバージョンを切り替えるには、Device_59インストールパッケ

ージをインストールし、ログインする必要があります。 

 

4. HCLはIRF2をサポートしていますか？ 
現在のHCLバージョンでは、S5820V2-54QS-GE、S6850、F1060、F1090がIRF2機能をサポート

しています。 

 

5. HCLシミュレータはVPLS実験をサポートしていますか？ 
HCLスイッチはVPLS実験をサポートしていませんが、シミュレーションにはルーターを使用できます。 

 

6. HCLシミュレータはQinQをサポートしていますか？ 
HCLシミュレータはQinQを部分的にしかサポートしていません。 

1) 基本QinQ 

2) QinQパススルーをサポート 

3) TPID設定をサポート 

4) QinQ関連の設定操作については、以下を参照してください。 

 

7. HCL でシミュレートされるデバイスは、最大いくつの接続

をサポートしますか？ 
HCL では、各デバイスの接続数は最大 7 に制限されています。ネットワークカード拡張機能を有効

にすると、最大 35 の接続をサポートできます。 

 

8. HCL でサポートされるデバイスの最大数はいくつです

か？ 
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HCL では、1 つのプロセスがサポートできるデバイスの最大数は 50 台に制限されています。 

 

9. デバイスのメモリ使用量を削減した後、OSPF ネイバーが 

FULL 状態に到達できませんか？ 
OSPF や BGP などのプロトコルは大量のメモリを占有するため、デバイスのメモリ使用量を削減す

ると、これらのプロトコルが正常に動作しなくなり、ネイバーを確立できなくなる可能性があります。

デフォルトのメモリは変更しないことをお勧めします。複数のデバイスをシミュレートする必要がある

場合は、シミュレータのリモートツールを使用して PC 間でネットワークを構築することをお勧めしま

す。 
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トラブルシューティング 
 

Hyper-Vの無効化（その１） 

 

WindowsでHyper-Vが有効になっていると、その他の仮想ツール(Oracle VM, VMwareなど)は稼働するこ

とができません。そのためHCLを使う場合はHyper-Vは無効にする必要があります。 

 

1. Windows8, 10, 11でHyper Vアプリケーションを無効にします。 

1.1. [スタート] ➡ [設定] 

1.2. [アプリ] ➡ [オプション機能] 

1.3. [Windowsのその他の機能] 

1.4. Hyper-Vを無効にする 

 

1.5. [Hyper-V]からチェックを外す 

1.6. [OK]をクリック 
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Hyper-Vの無効化（その2） 

 

Hyper-Vの無効化（その１）でHyper-Vを無効にしても完全には無効化されていない場合があります。その

際には、管理者として以下のDOSコマンドを実行します。 

C:\Users\masah> bcdedit 

Windows ブート マネージャー 

identifier              {bootmgr} 

device                  partition=\Device\HarddiskVolume1 

path                    \EFI\Microsoft\Boot\bootmgfw.efi 

description             Windows Boot Manager 

…… 

Windows ブート ローダー 

-------------------------------- 

…… 

systemroot              \WINDOWS 

resumeobject            {fbb27247-3256-11eb-aaaf-bc542fcb163b} 

nx                      OptIn 

bootmenupolicy          Standard 

hypervisorlaunchtype    Auto        Hyper-Vが無効化されていない 

C:\Users\masah> bcdedit /set hypervisorlaunchtype off       Hyper-Vを無効にする 

この操作を正しく終了しました。 

C:\Users\masah> 
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デバイスセキュリティでコア分離のメモリ整合性をオフにします 
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インストールが成功しても装置をワークスペースに配置しようとしたとき、配置した装

置を起動しようとしたときにエラーが出た場合、以下のRepairをクリックしてみてくだ

さい。 

 

 
 

 
 

 
 

このメッセージが出たらHCLを閉じて、再度HCLを起動してください。 

そうすると、解決することがあります。 

  



HCL-104 
 

Host(ローカルPC)からHCL上の装置へPing 

 

Windowsではセキュリティ強化のため、外部からのpingを受け付けないようになっています。そのため、ロ

ーカルPCからDOSプロンプトでpingコマンドでHCL上の装置へpingしても答えません。 

Pingにこたえるためには、以下のように有効にします。 

[Windowsファイアウォール] ➡ [詳細設定]  プロファイルの対象はドメイン 

 

 

 

[Windowsファイアウォール] ➡ [詳細設定] プロファイルの対象はプライベート 
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共通する問題点 
以下の記述は上記トラブルシューティングと重複する部分もありますが、正しく使用できない場合の参考にしてく

ださい。 

 

インストールに関する問題 
ダウンロード方法： 

H3C公式サイト（http://www.h3c.com）にアクセスし、ナビゲーションバーの「サポート - ソフトウェアダウ

ンロード」を選択してソフトウェア製品ページへ移動します。「その他の製品」を選択し、「H3C Cloud Lab」の

下にあるダウンロードリンクをクリックしてHCLダウンロードページへ移動します。 

インストールに関する推奨事項： 

Windows 11、Windows 10、Windows 7をご利用の場合は、HCL V5.0.0より新しいバージョンをインストー

ルし、組み込みのVirtualBox 6.0.14を使用することをお勧めします。また、Windows 10を推奨します。 

 

1. HCLのインストール完了後、起動できず、エラーメッセージが表示される場合： 

 
エラーメッセージのログファイルを取得してください。 

使用中に問題が発生した場合は、「Collect Log Information」機能を使用してログ情報を収集し、フィード

バックをお送りください。 

 

2. HCLのインストール完了後、HCLを起動すると、仮想マシンの起動が非常に遅くなります。コマンドライン

を開くとダイアログボックスが表示されますが、情報が表示されず、コマンドを入力できません。 

この問題は、ホストマシンのVT-xまたはAMD-V機能が有効になっていないことが原因で、仮想マシンの動

作が遅くなっています。HCLの仮想マシンの動作は、ホストマシンのVT-xまたはAMD-V機能に依存していま

す。HCLを実行するには、ホストマシンのVT-xまたはAMD-V機能が有効になっていることを確認してください。

これらの機能が有効になっていないホストマシンでHCLを実行することは推奨されません。 

 

3. HCLのインストール完了後、HCLの起動に失敗し、「VirtualBox is not installed, please install first」ま

たは「VirtualBox is not installed, please install first」というメッセージが表示されます。 

VirtualBoxのインストールパスはASCII文字以外をサポートしていません。また、システムユーザー名に

ASCII文字以外が含まれている場合、HCLは起動できません。システムユーザー名とインストールパスに

ASCII文字以外が含まれていないことを確認してください。 

 

4. HCLのインストール完了後、HCLを起動してデバイスを作成しようとすると失敗し、「Device creation 

failed」というメッセージが表示されます。 

1) デバイスの作成が初めて失敗した場合は、同じ種類のデバイスを再度作成してみてください。 

2) 「ワンクリック修復」機能のアイコン   を使用して修復し、HCLを再起動して再度試してください。 

3) VirtualBoxの残骸が残っている可能性があります。VirtualBoxを開き、Simware_Baseおよびその他
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のtopo-deviceデバイスを削除してから、HCLを起動してデバイスの作成を再度試してください。 

 

4) または、デバイスの残骸を削除した後、VirtualBoxをアンインストールし、VirtualBox VMsフォルダを

削除してください。コンピュータを再起動し、VirtualBoxを再インストールしてください。 

VirtualBoxを再インストールする前に以下のフォルダーを削除しておいてください。 

c:\program Files>Oracle>VirtualBox 

c:\users>ユーザー>.VirtualBox 

c:\Program Data>VirtualBox 
 

5. HCLのインストール完了後、HCLを起動するとデバイスの起動に失敗し、「Device startup failed」という

メッセージが表示されます。 

1) 主な原因は、VirtualBox終了時に残存しているプロセスです。デバイスの残存プロセスを削除し、

vBoxSVC.exeプロセスを終了してから、HCLを再度起動すると問題が解決します。 

2) VirtualBoxのバージョンが低すぎます。 

3) VirtualBox 6.0.14バージョンがWindowsの組み込み仮想化機能と競合しています。 

a. Windowsのセキュリティ設定で「コア分離」を無効にします。 

b. Windowsの機能で「Hyper-V」、「仮想マシンプラットフォーム」、「Windowsハイパーバイザープラッ

トフォーム」を無効にします。 

c. 通常、Windowsサービスで以下のサービスが次の状態になっているはずです。 

 
「システム情報」の「仮想化ベースのセキュリティ」が「無効」になっている。 

表示するにはコマンドプロンプトで「msinfo32」を入力 
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上記に該当しない場合は、システム内のHyper-V関連サービスが完全に停止していないことを意味します。 

 

6. HCLのインストール完了後、HCLの起動時に「Please check if the VirtualBox API is installed 

correctly」というメッセージが表示され、起動に失敗します。 

1) (Windows 7の場合) HCLのプロパティを開き、「互換性」タブで互換性をVistaに設定してください。そ

れでも問題が解決しない場合は、次の手順に進んでください。 

2) (Windows 7、Windows 10の場合) VBoxSVCプロセスが起動状態になっているか確認してください。 

3) VBoxSVCプロセスが起動していない場合は、VirtualBoxを手動で起動し、VBoxSVCプロセスが実行さ

れているか確認してください。 

4) VBoxSVCプロセスがそれでも起動しない場合は、VirtualBoxを再インストールし、コンピュータを再起

動してください（デフォルトのインストールパスにインストールすることをお勧めします。インストールパス

にはASCII文字以外の文字を含めないでください。再インストール前にレジストリをクリーンアップすること

をお勧めします）。 

 

7. HCLのインストール完了後、デバイスを起動し、kdbビューにアクセスしてください。 

シミュレータデバイスを起動し、異常なkdbビューに入った後、このデバイスの実行を停止し、デバイスアイ

コンを右クリックして「configure」を選択し、デバイスの実行メモリを増やしてください。1024M以内の範囲に

調整することをお勧めします。 
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8. HCLデバイスのインターフェースが正常に起動しない/異常にダウンする/インターフェースが起動しない。 

シミュレータデバイスを起動した後、接続されているインターフェースが正常に起動しない場合は、このデバ

イスの実行を停止し、インターフェースを再接続してから、デバイスを再度起動してください。 

9. SimwareWrapperに接続できません（アドレス 127.0.0.1/ポート 16600）。 

 
ポートがbでないか確認してください。 

ポートが使用されていない場合は、VirtualBoxとHCLシミュレーターをアンインストールしてみてください。 

管理者権限でコマンドプロンプトを開き、「netsh winsock reset」コマンドを実行してから、オペレーティング

システムを再起動し、シミュレーターを再インストールしてください。 

 

10. SimwareMultiCCに接続できません（アドレス：127.0.0.1/ポート16500）。 

問題9と同じです。 

 

11. デバイスを作成して起動した後、コマンドプロンプトウィンドウに10分以内に応答がない場合（Windows 

7はWindows 10よりも動作が遅い場合があります）、以下の手順を試してください。 

1) デバイス構成インターフェースのメモリを確認してください。メモリを増やすことをお勧めします。 

2) メモリの変更が効果がない場合は、対応するバージョンのvboxを開き、デバイスの作成に問題がない

か確認してください。下の画像は、作成されたMSR36タイプのルーターを示しており、デバイスのvmdkフ

ァイルが正常に読み取れます。デバイスに対応するvmdkファイルがここに存在しない場合は異常です。

HCL側でデバイスを削除して再作成してみてください。 
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3) デバイスの削除と再作成が効果がない場合は、vboxでデバイスを右クリックして手動で起動してみて

ください。 （通常、HCL使用時はVirtualBox側でデバイスを起動しないでください。） 

4). デバイスがVirtualBoxで起動しない場合は、HCLを再インストールする必要があります。 

 

12. HCLをインストール後、正常に動作しますが、しばらく経過後または再起動後にデバイスが起動しなくな

ります。HCLを再インストールしても、状況は変わりません。 

Perfect Worldなどのゲームソフトのアンチチートエンジンや一部のセキュリティソフトなど、一部のソフトウ

ェアがVirtualBoxソフトウェアの正常な動作を妨げる場合があります。 

 

仕様に関する問題 
1. HCLはどのデバイスをサポートしていますか？ 

HCLV5.10.1の公式バージョンでは、MSR3620デバイス、VSR88デバイス、S5820V2-54QS-GEデバイス、

S6850デバイス、F1060デバイス、F1090デバイス、AC、APをサポートしています。 

 

2. HCLでサポートされていない機能は何ですか？ 

現在のバージョンでは、以下の機能はサポートされていません。 

スイッチング製品：ポート分離、トラフィック統計、Netconf 

セキュリティ製品：IRFデュアルマシンホットスタンバイ 

ルーティング製品：ADWAN関連機能、SR、SRv6、FlexE、Netconf 

 

3. HCLでQoSアクセス制御が機能しないのはなぜですか？ 

この問題はQoSに限ったことではありません。 HCLシミュレータでは、QoS、MQC、ACLカウント統計、スーパ

ーVLANのARPプロキシ、ユーザーVLAN分離、ポート分離など、ハードウェアチップによる実装が必要な機

能は利用できません。 

注：スーパーVLAN関連の実験を行うには、デバイスをb59バージョン（デフォルトはb75バージョン）に切り替

える必要があります。デバイスバージョンを切り替えるには、Device_59インストールパッケージをインスト

ールし、ログインしてください。 

 

4. HCLはIRF2をサポートしていますか？ 

現在のHCLバージョンでは、S5820V2-54QS-GE、S6850、F1060、F1090がIRF2機能をサポートしています。 
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5. HCLシミュレータはVPLS実験をサポートしていますか？ 

HCLスイッチはVPLS実験をサポートしていません。シミュレーションにはルーターを使用してください。 

 

6. HCLシミュレータはQinQ実験をサポートしていますか？ 

HCLシミュレータはQinQを部分的にサポートしています。 

1) 基本的なQinQ 

2) QinQパススルーのサポート 

3) TPID設定のサポート 

4) QinQ関連の設定操作については、以下を参照してください。 

 

7. HCLでシミュレートされるデバイスは、最大でいくつの接続をサポートしますか？ 

HCLでは、各デバイスの最大接続数は7つに制限されています。ネットワークカード拡張機能を有効にする

と、最大35接続までサポートできます。 

 

8. HCLでサポートされるデバイスの最大数はいくつですか？ 

HCLでは、1つのプロセスがサポートするデバイスの最大数は50個に制限されています。 

 

9. デバイスのメモリ使用量を削減した後、OSPFネイバーがFULL状態にならないのはなぜですか？ 

OSPFやBGPなどのプロトコルは大量のメモリを消費するため、デバイスのメモリを削減すると、これらのプロ

トコルが正常に動作しなくなり、ネイバーを確立できなくなる可能性があります。デフォルトのメモリ設定を変

更しないことをお勧めします。複数のデバイスをシミュレートする必要がある場合は、シミュレーターのリモ

ートツールを使用してPC間でネットワーク接続を行うことをお勧めします。 

 

設定に関する問題 
1. プロジェクト内で複数のホストを作成し、それぞれ異なるIPアドレスを設定するにはどうすればよいです

か？ 

手順1：VirtualBox → ファイル → ホストネットワークマネージャーの順にクリックし、右側のプラス記号を

クリックして新しい仮想ネットワークカードを追加します。 

 
手順2：ホストネットワークマネージャーで、ネットワークアダプタ情報を作成および設定します。 
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2. HCLでPCアドレスを設定するにはどうすればよいですか？ 

設定手順：PCを起動後、PCを右クリックし、「設定」をクリックします（下図参照）。 

 
 

3. BGPのHCLでdefault medコマンドが有効にならないのはなぜですか？ 

これは、V5プラットフォームとV7プラットフォームの違いによるものです。V7プラットフォームでは、default 

medコマンドはインポートされたルートまたはローカルのネットワークルートにのみ有効で、他のデバイスか

ら学習したルートには有効になりません。したがって、V7プラットフォームにおけるdefault medの意味は、
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V5プラットフォームにおける意味とは異なります。 

 

4. FTPを使用してルーターにファイルをアップロードする際に、「550 権限拒否」というエラーが表示されま

す。 

「550 権限拒否」は、FTPユーザーに十分な権限がないことを意味します。これはV5とV7で異なります。V7

のセキュリティチェックは非常に厳格で、FTP権限を付与する前にユーザーロールレベルを指定する必要が

あります。定義済みのユーザーロール名と対応する権限については、H3C公式サイトのMSR36-20（V7）設

定ガイドを参照してください。 

 

5. シミュレータ内のデバイスでユーザー優先度を指定するにはどうすればよいですか？ 

シミュレータで使用されているデバイスはすべてComware V7プラットフォームのデバイスであり、一般的に

使用されているComware V5プラットフォームとはユーザー優先度が大きく異なります。 Comware V7プラッ

トフォームには、複数のユーザーロールが定義されており、それぞれのロールとロールの関係は以下のと

おりです。 

network-admin 

オペレーティングシステムのすべての機能とリソースを操作できます。 

network-operator 

システムのすべての機能とリソースに関する表示コマンドを実行できます（display history-command all

コマンドを除く。詳細は、ロール名network-operatorコマンドを参照してください）。 

ローカル認証を使用してシステムにログインし、このロールが付与されている場合、ユーザーは自身の

パスワードを変更できます。 

XMLビューに入るコマンドを実行できます。 

読み取りタイプのすべてのXML要素を操作できます。 

level-n（n = 0～15） 

level-0：ping、tracert、ssh2、telnet、superコマンドを実行できます。管理者はこれらのコマンドの権限

を設定できます。 

level-1：level-0ユーザーロールの権限を持ち、システムのすべての機能とリソースに関する表示コマン

ドを実行できます（display history-command allを除く）。管理者はこれらのコマンドの権限を設定できま

す。 

level-2～level-8 level-10～level-14：デフォルトの権限はなく、管理者が設定する必要があります。 

level-9：システム内のほとんどの機能とすべてのリソースを操作できます。管理者は権限を設定できま

すが、display history-command allコマンド、RBACコマンド（Debugコマンドを除く）、ファイル管理、デバ

イス管理、ローカルユーザー機能は操作できません。ローカルユーザーの場合、システムにログインして

このロールが付与されると、自分のパスワードを変更できます。 

level-15：network-adminロールと同じ権限を持ちます。 

 
6. HCL 

Comware V7プラットフォームでは、if-matchステートメントの形式がComware V5プラットフォームとは異な

ります。Comware V7プラットフォームのif-matchコマンドの形式は次のとおりです。 

if-match ip { address | next-hop | route-source } { acl acl-number | prefix-list prefix-list-name } 
 

7. HCLでBGPを設定する方法、およびV5プラットフォームのコマンドを設定した後、BGPネイバーが確立でき

ない理由は何ですか？ 

Comware V7プラットフォームにおけるBGPプロトコルの設定コマンドは以下のとおりです。 

bgp as-number 
peer ip-address as-number as-number 
address-family ipv4 
peer ip-address enable 
network x.x.x.x 

注：Comware V7プラットフォームでは、BGPルートはaddress-family ipv4ビューで公開されます。 
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8. ファイアウォールのログインパスワードは何ですか？ 

ファイアウォールのログインパスワードはadmin/adminです。 

 

9. ファイアウォールが直接接続されないのはなぜですか？ 

Comware V7プラットフォームのファイアウォールは完全禁止ポリシーを採用しており、関連するトラフィック

を許可するには、ローカルセキュリティドメインとインターフェースセキュリティドメイン間のドメイン間ポリシ

ーを設定する必要があります。 

 

10. Web経由でファイアウォールを設定する方法は何ですか？ 

ホストをローカルのVirtualBoxネットワークカードにブリッジ接続し、アドレスを設定し、ファイアウォールで関

連するドメイン間ポリシーを設定すれば、ブラウザから直接アクセスできます。 

HCLファイアウォールのWebモードでのログイン設定 

 

11. HCLシミュレータ関連デバイス設定マニュアル 

ルーターのサポートについては、公式ウェブサイト「H3C MSR3600ルーターシリーズ - H3C」を参照してくだ

さい。 

スイッチのサポートについては、公式ウェブサイト「H3C S6850スイッチシリーズ - H3C」を参照してください。 

ファイアウォールについては、公式ウェブサイト「H3C SecPathファイアウォールシリーズ設定ガイド（V7）-

6W402」を参照してください。 
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Windows Updateに関する問題 
いままで動いていたにも関わらす、Windows Updateを実行後、起動すると以下のようなエラーが発生する

ことがあります。原因としては、Host-Only Ethernet Adopterが自動増殖、GUID不整合、仮想NIC番号重

複などがあります。 

 

 
 

このエラーが出て起動できない装置は、HOSTとHost-Only Ethernet Adopterをadd linkしたものです。 

 
 

このばあい、VirtualBoxを修復(Repair)インストールします。 

1. 修復インストールする前に、以下のフォルダーを削除しておきます。 

c:\program Files>Oracle>VirtualBox 

c:\users>ユーザー>.VirtualBox 

c:\Program Data>VirtualBox 
 

2. インストールされているバージョンのVirtualBoxを再インストールします。 

 
 

Nextをクリック。 
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Repairを選択して修復作業を行います。作業終了後、PCをリブート後、再度HCLを起動すると、回復するこ

とができます。 

 

それでも、Host-Only Ethernet Adopterが回復しないようなら、一旦、VirtualBoxアンインストールして 

以下のフォルダーを消去してから、再度VirtualBoxをインストールします。 

c:\program Files>Oracle>VirtualBox 

c:\users>ユーザー>.VirtualBox 

c:\Program Data>VirtualBox 
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VirtualBoxのエラーメッセージ 
 

HCLでのエラーメッセージは多くの情報を含んでおりません。エラーの多くはVirtualBoxの動作にかかわる

ものですから、VirtualBoxのエラーを見るのも参考になります。 

VirtualBoxのエラーメッセージは以下のフォルダーにあります。 

 

c:\users>ユーザー>.VirtualBox 

エラーログ(VBoxSVC.log.1～n) 

 
c:\Program Data>VirtualBox 

エラーログ(VBoxSDS.log. 1～n) 

 

メッセージへの対処方法に関しては、ネットで検索すると有効な対処方法を見つけることができます。 

 
 


